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What is the CH3 Application?

The CH3 (methylation) application is a frame work used to identify 
methylation events in your samples. CH3 microarray analysis can help 
identify methylated regions isolated using affinity based methods such as 
methylated DNA immunoprecipitation. The sof tware helps you:

Identify molecular e vents associated with DNA methylation

Find and validat e gene regulation and regulatory networks by 
creating high- resolution, genome- wide methylation profiles

Show modes of action of compounds and target genes by 
understanding the relation of DNA methylation to transcriptional 
control

With the CH3 application, you can:

Import data from the Agilent Feature Extraction and Axon programs, 
and import UDF files

Use an intuitiv e graphical interface to display data and annot ations 
in the context of an organism’s gen ome, at se veral simultaneous 
levels of detail

Use a Z- score or BATMAN (Bayesian Tool for Methylation Analysis) 
algorithm to calculate the probability that probes are methylated or 
unmethylated

Compare the moving average of your log ratio and Z- score data 
within the boundaries of CpG Island track s

You cannot use w orkflow mode for methylation event detection.
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Using Agilent Genomic Workbench on a Mac

Windows command Equivalent Mac command

Right-click • Command-click ( -click)
• On Macs with trackpads, other options are available. On 

certain machines, you place two fingers on the trackpad 
while you press the button below the trackpad. See the user 
guide for your specific machine.

• If you have a third-party mouse that has more than one 
button, you may be able to use one of the buttons as a right 
mouse button.

Control-click Control-click (Same as the Windows command)

Shift-click Shift-click (Same as the Windows command)

 (Close button)  (Close button)
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Entering a License and Starting the CH3 Application

Home Open Application

Help

Figure 1 Open Application tab for CH3
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To enter your license for analyzing Methylation (CH3) data 
interactively

1 Open Application

2 License

Use a Server Location

1

2

3 Server Location

Figure 2 License tab of the User Preferences dialog box 
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4

ctrl V

5 Apply OK 

Enter a Text License

1

2

3 Text License

4
ctrl

V

5 Apply

6 OK

To start the CH3 application

• DNA Analytics 
(CH3 Module) 
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Using Main Window Components to Display/Analyze Data

viewing

analysis

What are the main window components?

•

•

•

•
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Figure 3 Agilent Genomic Workbench 7.0 showing main components for CH3

Command Ribbon

Genome
View

Chromosome
View

Gene
View

Tab View

The View Cursor

Switch Applications

Genomic
Viewer

Tabs

Status Bar
Navigator
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What can you do with the main components for display of data and 
results?

Table 1 Components of Agilent Genomic Workbench main window for display of data 
and results

To do this Use this part of the main window

Change program to CGH, ChIP, 
Methylation (CH3), Expression, 
microRNA, or SureSelect Target 
Enrichment module

Switch Application button: Click the button and click the 
program module you want to open. The window and 
options are different for the different program types.

Import or export data Home tab: Click the Import or Export button to select the 
data you want to import or export. See Chapter 2, 
“Importing, Managing, and Exporting CH3 Data and Other 
Content” for more information.

Select array data to display in the three 
graphical views or in the Tab View as a 
table

Experiment pane of the Navigator: Create an experiment 
with the imported data, select the experiment, and then 
select the data within the experiment to display or 
analyze. See Chapter 3, “Displaying CH3 Data and Other 
Content” for more information.

Display array data/results for only a 
certain portion of a chromosome

Genome View: Select a chromosome to display in 
Chromosome View. You cannot view log ratio data points 
here.

Chromosome View: Select a gene region to display in 
Gene View. You can display log ratio data points here if 
you select Scatter Plot in the View Preferences dialog 
box.

Gene View: See the log ratio data next to a selected 
region of a chromosome, with associated genes and 
track-based annotation. See Chapter 4, “Setting Up 
Methylation (CH3) Analysis” for details about these 
Views.
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Show/Hide or customize the data 
points for the scatter plots

Gene View: Move the mouse pointer over Scatter Plot to 
display the options. Or, right-click and then click View 
Preferences.

Chromosome View: Right-click and then click View 
Preferences.

View tab: Click View Preferences.

See Chapter 3, “Displaying CH3 Data and Other Content” 
for information on how to do this.

Display array data next to tracks or 
gene lists

My Entity List pane of Navigator: Add or select a track or 
gene list to have it appear in Gene View. 

See Chapter 3, “Displaying CH3 Data and Other Content” 
for information on how to do this.

Change the appearance of the display View Tab: Click View Preferences. From the View 
Preferences dialog box, you can change the orientation, 
select what type of data to view, and configure scatter 
plot options.

Genomic Viewer: Right-click any View except the Tab 
View and select View Preferences. In the View 
Preferences dialog box, you can select to show or hide the 
scatter plots and how to display them, including results. 

See Chapter 3, “Displaying CH3 Data and Other Content” 
for more information.

Analyze or reanalyze displayed data Preprocessing Tab: Click this tab to display commands 
you use to manipulate the data before you apply the 
algorithms.

Analysis Tab: Click this tab to display commands you use 
to analyze the data.

Reports Tab: Click this tab top display commands you use 
to generate and manage reports.

For more information on what you can do in these tabs, 
see “Tabs” on page 24.

Table 1 Components of Agilent Genomic Workbench main window for display of data 
and results (continued)

To do this Use this part of the main window
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Switching Applications

Figure 4 Switch Application menu
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Using Tabs and Command Ribbons 

Tabs

tab

Figure 5 Tabs for CH3 interactive analysis

Tabs CH3 Capabilities

Preprocessing Combine (fuse) array designs

Analysis Calculate a moving average on log ratio data

Calculate a moving average on ZScores generated by probe 
methylation algorithm

Apply probe methylation algorithm

Apply BATMAN algorithm

Reports Generate probe report

Generate BATMAN report
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Commands

command ribbon

Figure 6 Home command ribbon for CH3 interactive analysis
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Using the Navigator to Search for Data

Sample Manager User Guide 

Figure 7 Navigator panes

Search pane

Data pane

Experiment pane

My Entity List pane
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Pane Comments

Search Lets you search within any pane of the Navigator for a specific 
item (array or build, for example). You must type the entire array 
name or term; otherwise, use asterisks (*) as wild cards for 
unspecified strings. For example, type *1234* to find any item that 
contains “1234”.

Data Contains microarray data files, organized by application, then by 
design and genome build. 

Shows all probe groups and microarray designs that are available 
to you, organized by folders. In general, you can:

• Expand or collapse folders to show or hide content.
• Right-click the name of a folder or item to open a shortcut menu 

that lets you take action on the item.
See “Data pane – icons, special text, and buttons” on page 140 
and “Data pane – actions and shortcut menus” on page 140.

Experiment Contains Agilent Genomic Workbench experiments. Experiments 
are organizational units that contain links to microarray data and 
design files. In data analysis modules, experiments also contain 
saved results.

My Entity List Contains gene lists and tracks:
• Gene Lists are collections of genes of interest. You can create 

them within the program, import and export them, and apply 
them to Gene View and Chromosome View.

• Tracks are collections of annotation or other information that 
map to specific genomic locations. You can import, export, and 
combine tracks, and display them in Gene View with your array 
data and analysis results.

My Networks Contains the biological networks/pathways that you found using 
Network Search or that you create using a literature search in 
eArrayXD. For more information, see the eArrayXD Users Guide.
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To search the Navigator

Figure 8 Search pane of the Navigator

1
All Panels.

2

3

4

•

•

5
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Using the Genomic Viewer to Display Data

What is the Genomic Viewer?

• Genome View

• Chromosome View

• Gene View

• Tab View
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Figure 9 Genomic Viewer in vertical orientation

Genome View

Chromosome View

Gene View

Tab View
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To change the size of and detach panes from the Agilent Genomic 
Workbench main window

•

•
Detach

Figure 10 Changing the size of and detaching panes

Click here
to detach View

Drag a border to 
to resize pane
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To maximize and reattach panes to the Agilent Genomic Workbench 
main window

• Maximize

•
Close

Figure 11 Maximizing and reattaching panes

Click here to
reattach View

Click here
to maximize View
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General Instructions for Displaying Microarray Data/Results

An experiment is
the folder that

holds data from
any array set you

select for the
experiment. The
folder also holds
analysis results.

•

•

•

•

Data 
Viewing User Guide.

Figure 12 Typical pathway for displaying microarray data/results

Change to the 
CH3 application

Turn on scatter 
plot options

Import 
design files

Add data to the new 
experiment

Create an 
experiment

Review data 
(tracks and 

genomic 
boundaries)

Select arrays to 
display

Select the 
experiment

Import data files
• Agilent FE files

• Axon files

• UDFs
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General Instructions for Setting Options for CH3 Interactive 
Analysis

Figure 13 Typical analysis pathway – Interactive mode for CH3 application

Set up and select 
experiment 

Select /deselect 
arrays to include 

in reanalysis

Combine
designs 

Compare moving 
average of log 

ratio and Z-score 
data with genomic 

region tracks

Generate reports

Display and save 
results

Apply Z-score 
and/or BATMAN 
algorithms to find 

methylation 
events
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Getting Help

To get help within Agilent Genomic Workbench

Help Resource Description/Instructions

Methylation (CH3) 
Analysis User Guide

This user guide, which you are now reading, supplies comprehensive 
help on all available CH3 tasks. You can access it easily from anywhere 
within the program.

1 In any tab of Agilent Genomic Workbench, click the Help tab.
2 On the Help Ribbon, click Application Guide.

Methylation (CH3) Analysis User Guide opens.

Other User Guides The Help tab in Agilent Genomic Workbench lets you view any of the 
available user guides that apply to the currently selected application 
type.

1 Set the desired application type. See “Switching Applications” on 
page 23.

2 In the Agilent Genomic Workbench tab bar, click Help.
The names of the available user guides appear in the command 
ribbon.

3 Click the desired user guide.
The selected user guide opens.

Product Overview Guide An additional guide gives an overview of the capabilities within Agilent 
Genomic Workbench and describes how to start and find help for all of 
the programs. In addition, it helps you with system administration and 
troubleshooting. 

1 In any interactive analysis tab of Agilent Genomic Workbench, click 
the Open Application tab.

2 At the upper right corner of the Open Application tab, click Product 
Overview.
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To contact Agilent Technical Support

To learn about Agilent products and services

Resource To find technical support contact information

Agilent Technical Support 
Web site

1 Go to http://chem.agilent.com.
2 Select a country or area.
3 Under Quick Links, select Technical Support.
4 Select from the available links to display support information.

Contact Agilent Technical 
Support by telephone or 
e-mail (United States and 
Canada)

Telephone: (800-227-9770)

E-mail: informatics_support@agilent.com

Contact Agilent Technical 
Support by telephone or 
e-mail (for your country)

1 Go to http://chem.agilent.com.
2 Select Contact Us.
3 Under Worldwide Sales and Support Phone Assistance, click to 

select a country, and then click Go. Complete e-mail and telephone 
contact information for your country is displayed.
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Importing Files

Type of file Description See these topics

Microarray data files • Agilent Feature Extraction 
(*.txt) data files

• GenePix/Axon (*.gpr) data 
files

• Universal Data Files (UDFs) 
(*.txt files)

“To import Agilent FE or Axon 
data files” on page 41
“To import a UDF file” on 
page 43

Microarray design files • Agilent GEML (*.xml) design 
files

• GenePix/Axon (*.gal) design 
files

“To import Agilent GEML 
design files” on page 39
“To import Axon design 
files” on page 41

Genome builds Agilent-supplied genome 
information for human, mouse 
and rat genomes

“To import a genome build” on 
page 46

Tracks BED format annotation track 
files

“To import tracks” on page 47

Array attributes .txt files that you have created 
yourself or previously exported 
from Agilent Genomic 
Workbench

“To import array attributes” on 
page 48

Experiments ZIP format file of experiments 
exported from Agilent Genomic 
Workbench

“To import an experiment 
file” on page 49
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To select a different location for data files

C:\Program Files\Agilent\Agilent Genomic Workbench <version>\data

1 User Preferences.

2 Miscellaneous Data Location, Browse.

3 Open.

4 OK.

To import Agilent GEML design files

CAUTION Do not select a location that contains a backup data folder; the current data overwrites 
the data in the folder you select.

NOTE
• Catalog design files must be downloaded from the eArray Web site.
• Designs with multiple genome builds are supported for both Catalog and custom designs. For 

Catalog designs, the design must first be downloaded from the eArray Web site. You can then 
import the design for other genome builds.
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1 Import > Design Files > GEML File.

2
ctrl

3 Open.

• Valid

•
Overwrite 

•
Update 

•

• Corrupt

Remove

4 Start Import.
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To import Axon design files

1  Import > Design Files > Axon File.

2
ctrl

3 Import.

• Valid

• Corrupt

Remove

4 Species Genome Build.

5 Start Import.

To import Agilent FE or Axon data files

•

•

•
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1

• Import > Array Files > FE 
File.

• Import > Array Files > Axon File.

2

3

• Open.

• Import.

4

Setting Comments

Name The names of imported arrays are often cryptic. You can give 
any array a more meaningful label.
a Double-click the name of the array.
b Edit the name, as desired.
c Press Enter.
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5

• OK.

• Run in Background.

To import a UDF file

•

•

•

•

•

•

Dye Flip For each array:
• Select Normal if:

• The test samples were labeled with cyanine-5 (red).
• The control samples were labeled with cyanine-3 (green).
• The imported ratio (test/control) should be reported 

directly.
• Select Flipped if:

• The test samples were labeled with cyanine-3 (green).
• The control samples were labeled with cyanine-5 (red).
• The imported ratio (control/test) should be reported with 

the ratio inverted (test/control).
The program does not combine dye-flip pairs.

Overwrite arrays with 
duplicate names

If you mark this option, the program deletes an existing array 
data file if it has the same name as one you import.

Setting Comments
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1 Import > Array Files > UDF File.

2 Open.

3

4 Continue.

5

Select Mapping,

Setting Comments

Experiment Name By default, the program creates an experiment with the same 
name as the imported file. To change the name:

a Double-click the name.
b Edit the name as desired.
c Press Enter.

Data type • Select the mathematical form of the signal intensity data for 
the array. The options are ratio, log2 ratio, log10 ratio, and 
ln ratio.

Design type • Select CH3.
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6 species Genome Build

7

a Save Mapping As.

b OK.

8

a , Use System Generated ArrayID.

b

Sample Manager User 
Guide

9 Import

10

Label Description

ProbeName The column contains names of probes.

ChrName The column contains names of chromosomes.

Start First chromosomal location for the probe.

Stop Last chromosomal location for the probe.

Description Text annotation related to the probe.

LogRatio The column contains array data values that correspond to each probe. 
You can use this label more than once.
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•

a Yes.

b ctrl

c Open.

•
No.

11 OK.

To import a genome build

1 Import > Genome Build.

NOTE Use arrays from a single genome build in an experiment.
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2

3 OK.

To import tracks

1 Import > Track.

2

Setting Instructions

Species • Type the genome’s species of origin, as you would want it to 
appear within the program. 

Build Name • Type the name of the genome build you want to import, as 
you would want it to appear within the program. 

Refseq File This file contains information on gene locations for Gene View.

a Click Browse.
A dialog box appears.

b Select the desired file, then click Open.

Cyto-band File This file contains the graphic information on the cyto-bands 
for Genome and Chromosome Views.

a Click Browse.
A dialog box appears.

b Select the desired file, then click Open.

Setting Instructions

Species • Select the species to which the track applies.

Build Name • Select the specific genome build of the species to which the 
track applies.
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3 OK.

To import array attributes

Sample Manager User Guide 

1 Import ArrayAttributes

2 Import.

No
Yes

Track Name • Type a name for the track. 
This name identifies the track within the program, including 
the name that appears if you include the track in Gene View.

Track File a Click Browse.
A dialog box appears.

b Select the name of the track (*.bed) file that you want to 
import.

c Click Open.
The location of the file appears in Track File.

Setting Instructions
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To import an experiment file

•

•

1 Import > Experiments.

2
OK.
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Working with Experiments to Organize Imported Data

experiments.

links

To display the array designs and data in the program

•

Figure 14 Data pane of the Navigator
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To create a new experiment

experiments

links

1 Create Experiment.

2 Name Description

3

• OK.
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•

a Properties.

b Select Design,

c Array List,
ctrl

d

e OK.

•

a OK.

b

c
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Figure 15 Experiment pane of the Navigator

To add arrays to an experiment

1 Experiment Experiments

2 Show Properties.

3 Select Design,

4 Array List,

ctrl

5
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6 OK.

1

2

To change the order of arrays in an experiment

1
Edit Array Order.

2 Design,

3

NOTE If you add arrays to a selected experiment, and analysis options are marked (for example, 
Probe Methylation or Batman), you need to clear and then mark these options again to 
apply the analysis to the arrays.
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•

•

•
Order by.

4 OK.

To change the display names for arrays in an experiment

1

2 Show Properties

3 Display Name by

OK  

NOTE To change the name of an array that is displayed throughout Agilent Genomic Workbench, 
change its Global Display Name using Sample Manager. For more information, see the 
Sample Manager User Guide.
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To rename an array in an experiment

1 Experiment

2 Rename.

3 OK.

To remove arrays from an experiment

1 Experiment

2 Arrays Calibration Arrays
ctrl 

3 Delete.

4 Yes.
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To select or remove calibration array(s)

To select an array as a calibration array

1 Experiment

2 Select for 
Calibration. 

Set for Calibration

To deselect an array from calibration 

1 Experiment

2 Deselect from 
Calibration. 

Deselect from 
Calibration.

ctrl 

Shift 
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To show or hide array attributes in an experiment 

1

Sample Manager User Guide

2 Sample Attributes

3 Show/Hide Attributes

4

5 Save

6 Close

7 Close

To display or edit array attributes in an experiment

1

2 Sample Attributes

NOTE You cannot hide the required attributes. These include Array ID, Global Display Name, 
Green Sample, Red Sample (for 2-color arrays), and Polarity.

NOTE You cannot create new attributes using this dialog box. To do this, you must use the Sample 
Manager tab. See the Sample Manager User Guide.
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Sample Manager Guide

3

4 Save Changes

5 Close

To display or edit the attribute values of a specific array

1

Experiment

2 Show Properties.

3 Close.

NOTE You cannot change Array ID, Polarity, Extraction Status, or IsMultiPack attributes for 
extracted or UDF arrays.

NOTE You use the Sample Manager tab to organize, create, import, and export array attributes. 
See the Sample Manager User Guide.
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Managing Content

To display a list of the content stored in the program
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Figure 16 Navigator panes

Data pane

My Entity List pane
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To find specific content items in the Navigator

1

2

3

4

To display the properties of a specific design

1

2 Show Properties.
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To update probe annotation in design files

Help. 

1 User Preferences.

2 eArray User Details, 
Username Password. 

3 OK.

4

5 Update from eArray. 

6 Yes.

To rename an array in the Data pane

1

2 Rename.
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3 OK.

To remove data or design files from the program

1

2

3

•
ctrl

•
ctrl

4
Delete.

5 Yes.

CAUTION When you delete files, you permanently remove them from Agilent Genomic 
Workbench. To restore deleted files, you must import them again.
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To create a gene list

1

a

b

c

2
Create Gene List

3

4

5 OK.
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To import a gene list

1 My Entities List Entities

2 Gene List Import Gene List.

3
ctrl

OK.

To display the genes in a gene list

1 My Entity List

2 View In Table.
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To add one gene list to another

1 My Entity List

2 Add to Gene List.

3 Select target gene list,

4 OK.

To rename a gene list 

1 My Entity List

2 Rename.

3 OK.

To delete gene list(s)

1 My Entity List Gene 
List

2 ctrl

3 Delete.

4 Yes.
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To display the details of a track

1 My Entity List

2 View Details.

3

To combine tracks

1 My Entities List Entities

2 Tracks Combine Tracks.

3 Name,

4 New Condition.

5 Track,

6 New Condition,

Delete Condition.
Reset.

7 Operator,
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8 Save.

9 Close.

To rename a track

Show In UI

1

2 Rename.

3 OK.

Operator Comments 

AND Creates a combined track out of 2 tracks that will contain elements that appear 
in both tracks

OR Creates a combined track out of 2 tracks that will contain elements that appear 
in either of the tracks

MINUS Removes the elements of the second track from the first track.
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To delete tracks

1

2 ctrl

3 Delete.

4 Yes.
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Exporting and Saving Content

To export array attributes

1 Home > Export > Array Attributes.

Export Attributes

2

3

ctrl

4

5 Next
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6

a

b

7 OK

8 Export

To export experiments

1 Export > Experiments.

2
Select All.

3 OK.

4

5 Export.
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To export a gene list

1
Save As.

2

3 Save.

4 OK.

To export tracks

1 Export > Tracks

2 Select 
All.

3 OK.

4
Export.
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To copy what you see in the main window

1  Copy.

2

All.

3
Edit > Paste,

To copy the list of array colors for an experiment

1 Experiments

2 Edit Array 
Color.

3 Edit > Copy.

4 Edit > Paste,

NOTE To adjust how data is displayed in the panes, use the View Preferences dialog box. See 
“View Preferences” on page 236 for more information.
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To save data and design information from an experiment

1 Experiments

2 Save As 
Text File

3 Save.
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Agilent Genomic Workbench – Methylation (CH3) Analysis 
User Guide

Agilent Technologies

3
Displaying CH3 Data and Other Content

Selecting an Experiment 78

You can also manage all of the colors for all of the arrays in an experiment. 
Right-click the desired experiment, then click Edit Array Color. For 
more information, see “Edit Array Color” on page 186.Displaying Array 
Data 82

Displaying Content (Gene Lists/Tracks) 90

Searching for Probe and Gene Information 98
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Selecting an Experiment

To select an experiment

1

•
.

•

2

3 Yes.
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selected

To select or deselect arrays in the experiment

To select the arrays for analysis before experiment selection:

1 Shift
ctrl

2 Select
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To select or deselect arrays in a selected experiment:

1

2

ctrl

Shift

3 Select.

4

•

• ctrl

•
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To change the display color of an array

1

2 Edit Array Color.

3

4 OK.

Dialog box tab Instructions

Swatches • Click the desired color swatch.

HSB 
(Hue/Saturation/Brightness)

Type or adjust the values in H (Hue), S (Saturation), and B 
(Brightness), or alternately, follow these steps:

a Select H, then drag the slider to select a hue based on the 
color strip to its right.

b Click an appropriate location in the large color box to the 
left of the slider to set the saturation and brightness levels 
of the color.
Both the HSB and equivalent RGB values of the color 
appear in the dialog box. Note these values; they will be 
useful if you need to duplicate this color in the future.

RGB (Red/Green/Blue) Do any of the following. Note the final RGB Values; they will be 
useful if you need to duplicate this color in the future.

• Drag the Red, Green, and Blue sliders.
• Type or adjust values in the boxes to the right of the sliders.
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To display the scatter plots

1 View Preferences

2 All 
views Scatter Plot

1 View Preferences

2 All 
views Scatter Plot
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To show or hide data in the scatter plots

1
Scatter Plot,

2

To customize scatter plot ranges and colors

Add and customize a range

1 Scatter Plot

2 Methylation Results Log Ratios

3 Color by

4 Configure Color and Ranges

To do this Follow these steps

Show or hide the Methylation 
Results plot and color the results 
by Z-Score values 

• To show the data points – Mark the Methylation Results 
check box and select Z-Score Values from the list. 

• To hide all data points – Clear the Methylation Results 
check box.

Show or hide Log Ratio values in 
the Log Ratios plot

• To show the data points – Mark the Log Ratios check box 
and select Log Ratio Values from the list. 

• To hide all data points – Clear the Log Ratios check box.

Show or hide log ratios and 
color-code them by Probe Score 
values in the Log Ratios plot

• To show the data points – Mark the Log Ratios check box 
and select Probe Score Values from the list.

• To hide the data points, Clear the Log Ratios check box.

Change the ranges and colors for 
all scatter plots

• Click Configure Color and Ranges to enter ranges and 
change colors. See “Configure Coloring Ranges and 
Shades” on page 174 for more information.
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5
Methylation Results Log Ratios

6

7 Color Select Color

8 OK Select Color

9 Add Range

10 OK

Edit or remove a range

1
Methylation Results Log Ratios

2 Edit/Delete

3 Edit Range

4 Delete Range

5 OK

To change scatter plot appearance

1 View Preferences.

View Preferences
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2

3 OK.

To do this Follow these steps

Show or hide the scatter plot a In the View tab under Data Visibility, in View, select All 
Views.

b Do one of the following:
To show the scatter plot, mark Scatter Plot.

To hide the scatter plot, clear Scatter Plot.

c Click OK.

Change the symbol that 
appears for data points

You can select the symbol separately for each design type.
a In the View tab, under Rendering Patterns, select the 

desired Design type.
b Under Styles, for each data type, select the desired symbol.
c Click Apply.

Show a separate scatter plot 
in Gene and Chromosome 
Views for each selected array

a In the View tab, under View Alignment, under Rendering 
Style, select Stacked.

b Click Apply.

Show one scatter plot that 
contains data for selected 
arrays

a In the View tab, under View Alignment, under Rendering 
Style, select Overlaid.

b Click Apply.

Enable ToolTips for the 
scatter plot in Gene View

ToolTips show information about an individual data point when 
you place the pointer over it.
a Click the View tab.
b Under Data Visibility, in View, select Gene View.
c Mark Scatter Tool Tip.
d Click Apply.
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To print the scatter plot

1 Print

2 OK.

To create custom scales for Views

1 View Preferences.

2  
Apply

3

To locate and display data (or results) within the Views

To do this Follow these steps

Select a specific chromosome 
to display

• In Genome View, click the chromosome. 
All other views switch to the selected chromosome.

Display data in a region of the 
selected chromosome

• In Chromosome View, drag the pointer over the region.
Gene View expands (or shrinks) to show only the selected 
region. Tab View scrolls to the new cursor location.
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Zoom in and out in Gene View • Click  to zoom in.

• Click  to zoom out.

Scroll through the selected 
chromosome

• Click  to scroll up.

• Click  to scroll down.
Note: These arrows will appear side by side for horizontal 
orientation.

Re-center Gene View or 
Chromosome view

Click anywhere in Chromosome View, or anywhere within the 
scatter plot in Gene View. 
The location you click becomes the new cursor location.

Move all views to a specific 
genomic location

a Click Home > Go To Gene/Genomic location.
A dialog box appears.

b Under Genomic Location, select a Chromosome, and type a 
Base Position.

c Click Go.
All views move to the selected location.

Display the location of a 
specific gene in the center of 
all Views

a Click Home > Go To Gene/Genomic location.
A dialog box appears.

b Under RefSeq by Symbol, either select the gene (if 
available) or type the name of the gene.

c Click Go.
All views move to the location of the selected gene.

Display the data selected in 
Tab View in the center of 
Chromosome and Gene Views

• In Tab View, click any entry in any table, except a column 
heading.
Chromosome and Gene views: The genetic location of the 
selected data appears in the center of Chromosome and 
Gene Views.

Scroll to a specific column in 
Tab View (for the selected 
chromosome)

a In Tab View, right-click any column heading, then click 
Scroll To Column.
The Scroll to Column dialog box appears. See “Scroll to 
Column” on page 214.

b In Select Column, select the column.
c Click OK.

To do this Follow these steps
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Zoom in and out in Gene View • Click  to zoom in.

• Click  to zoom out.

Scroll through the selected 
chromosome

• Click  to scroll up.

• Click  to scroll down.
Note: These arrows will appear side by side for horizontal 
orientation.

Re-center Gene View or 
Chromosome view

Click anywhere in Chromosome View, or anywhere within the 
scatter plot in Gene View. 
The location you click becomes the new cursor location.

Move all views to a specific 
genomic location

a Click Home > Go To Gene/Genomic location.
A dialog box appears.

b Under Genomic Location, select a Chromosome, and type a 
Base Position.

c Click Go.
All views move to the selected location.

Display the location of a 
specific gene in the center of 
all Views

a Click Home > Go To Gene/Genomic location.
A dialog box appears.

b Under RefSeq by Symbol, either select the gene (if 
available) or type the name of the gene.

c Click Go.
All views move to the location of the selected gene.

Display the data selected in 
Tab View in the center of 
Chromosome and Gene Views

• In Tab View, click any entry in any table, except a column 
heading.
Chromosome and Gene views: The genetic location of the 
selected data appears in the center of Chromosome and 
Gene Views.

Scroll to a specific column in 
Tab View (for the selected 
chromosome)

a In Tab View, right-click any column heading, then click 
Scroll To Column.
The Scroll to Column dialog box appears. See “Scroll to 
Column” on page 214.

b In Select Column, select the column.
c Click OK.

To do this Follow these steps
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Search for a specific column 
entry in Tab View, and move 
the cursor there

a In Tab View, right-click any entry except a column heading, 
then click Find in column.
The Find in column dialog box appears. See “Find in 
column” on page 197.

b Set the search parameters, then click Find Next.
The program searches the column using your search 
parameters, and highlights the row of the first entry that 
matches. The cursor moves to the location defined in the 
highlighted row.

Display the exact 
chromosomal location of the 
cursor

At the bottom of the main window, look at the first cell of the 
Status bar. The location appears as the chromosome followed 
by the base position. For more information on the status bar, 
see “Status Bar” on page 165.

To do this Follow these steps
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Displaying Content (Gene Lists/Tracks)

To show gene lists in Gene View

1 Gene List

2

•
Highlight.

•
Show only. 

Show All.
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To select gene list display color

1 Gene List

2
View in Table.

3 Color, Color.

4

5 OK.

6 OK.

To display a gene list as a table

1 Gene List
View in Table.

2 OK.
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To change the appearance of genes in Gene View

1 User Preferences.

2 Tracks

3

4 OK.

To show tracks in Gene View

1

2

3 Show In UI

To do this Follow these steps

Show or hide genes in Gene 
View

a Under Visualization Parameters:
To show genes – Under Genes, mark Show Gene Symbols.

To hide genes – Under Genes, clear Show Gene Symbols.

b Click Apply.

Change the display font for 
genes (and track annotations) 
in Gene View

a In the Gene Symbols tab, under Font, select a new Font, 
Font Style, and Font Size.

b Click Apply

Change the display angle for 
genes (and track annotations) 
in Gene View

a Under Visualization Parameters, under Genes, in 
Orientation (Degrees), type a new orientation in degrees. 
0º is horizontal.

b Click Apply.
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1
User Preferences.

2 Tracks

3 Show In UI

4 OK.

To change the appearance of tracks

To do this Follow these steps

Include track information in 
reports

a In the list of tracks, in the Show in Report column, mark the 
check boxes of the desired tracks.

b Click Apply.
Doing this adds a column with the hits from the track file. For 
each aberrant interval, it reports the entries from the track file 
for that interval in that separate column.

Show or hide annotations in 
all tracks

• To show annotations in all tracks: under Tracks, mark Show 
Annotations.

• To hide annotations in all tracks: under Tracks, clear Show 
Annotations.

Display all selected tracks as 
a single track

• Under Tracks, mark Show Overlaid.
The program combines the annotations of all selected 
tracks into a single track named Overlaid Track.

• To show tracks individually again, clear Show Overlaid.

Display the parameters and 
the list of annotations of a 
track 

• In the list of tracks, for the desired track, click Details.
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To show track information in reports

1 Show in Report

2 Apply.

Change the display font for 
track annotations (and genes)

a Under Font, select a new Font, Font Style, and Font Size for 
track annotations.

b Click Apply.
The program changes the display font of track annotations 
and genes in Gene View.

Change the order in which 
tracks appear in Gene View.

The order of tracks in the Gene Symbols tab controls the 
left-to-right order of tracks in Gene View.

a Click the name of the track you want to move.
b Do any of the following:

• To move the track up in the list of tracks (and farther left 
in Gene View), click its name, then click Up.

• To move the track down in the list of tracks (and farther 
right in Gene View), click its name, then click Down.

c Click Apply.

Change the display angle of 
track annotations (and genes)

• Under Genes, in Orientation, type a new orientation (in 
degrees). 0º is horizontal.
The program changes the display angle of track annotations 
and genes in Gene View.

To do this Follow these steps

NOTE The annotations that are displayed in tab view are taken from the design file. This may 
include names of genes and other annotations. The positions of these genes may also be 
supplied as a separate Gene track and may contain unnecessary information.
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To limit data to the genomic boundaries of the track

1

2 Genomic Boundaries

To display a track in UCSC Browser

1

2 Show in UCSC

3

To upload a track to UCSC Browser

1 Upload Track to UCSC

2

3
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Figure 17 Track displayed in UCSC browser
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To change the graphical display to a different genome build

•
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Searching for Probe and Gene Information

To search Tab View for specific probe information 

1
Find in column.

2

3 Find Next.

Find Next

NOTE The Find in column function works within the selected chromosome.

Parameter Comments/Instructions

Find in column • Type the text you want to find (the search term). This can be an entire 
entry, or part of one.

Direction • Select one of these options:
• Up – Search the column upwards from the current cursor location 

(the highlighted row of the table).
• Down – Search the column downwards from the current cursor 

location (the highlighted row of the table).
Tip: Click a row in Tab View to highlight it.

Conditions • Mark any of these, as desired:
• Match Case – Find entries that match upper and lower case 

characters in the search term.
• Match whole word – Find an entry only if the entire entry matches 

the search term.
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String not found

4 Cancel .

To search Agilent eArray for probe information

1
Search probes in eArray

2

•
For complete gene view.

• User Defined,
Chromosome Start Stop

3 OK.
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To search the Web for information on probes in Tab View

1

2

To create a custom Web search link

1
Customize Link.

2 New.

3 URL name,

4 OK.

5 URL,
<target>

http://www.google.com/search?hl=eng&q=<target>

6 Update  Yes.
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To update or delete a custom Web search link

1
Customize Link.

2 URL Name,

3

4 Close.

To do this Follow these steps

Update a Web search link a Edit the URL name and the URL as needed.
b Click Update.

A Confirm dialog box appears.
c Click Yes.

Delete a Web search link • Click Delete.



3 Displaying CH3 Data and Other Content
To update or delete a custom Web search link

102 Methylation (CH3) Analysis Guide



103

Agilent Genomic Workbench – Methylation (CH3) Analysis 
User Guide

Agilent Technologies

4
Setting Up Methylation (CH3) Analysis

Working with Methylation Options 104

Changing Preprocessing and Analysis options 105

Displaying results and generating reports 111



4 Setting Up Methylation (CH3) Analysis
Working with Methylation Options

104 Methylation (CH3) Analysis Guide

Working with Methylation Options

Figure 18 Tabs available in the CH3 application

Table 2 Methylation analysis topics

Subject See these topics

Changing Preprocessing 
and Analysis options

“To combine (fuse) arrays” on page 105

“To set up a moving average (Log Ratio) calculation to smooth the 
data” on page 107

“To set up a moving average (ZScore) calculation to smooth the 
data” on page 108

“To apply methylation (CH3) event detection” on page 109

“To apply BATMAN (Bayesian Tool for Methylation Analysis)” on 
page 110

Displaying results and 
generating reports

“To display results of analysis” on page 111

“To upload a track to UCSC” on page 113

“To save a result” on page 114

“To restore a saved result to the display” on page 115

“To generate a probe report” on page 115

“To generate a Batman report” on page 118
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Changing Preprocessing and Analysis options

To combine (fuse) arrays

•

•

•

•

•

1

2
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3 ArraySet

a Experiment
 Show Properties.

b Value,

c

d Close.

4 Preprocessing Combine, Fuse.

5

• Select Normalization None Centralization.

• Remove arrays from experiment after fuse 

6 Continue. 

NOTE Double-check the values in the ArraySet Attribute column of the dialog box. Agilent 
Genomic Workbench combines all of the array pairs that have the same value for this 
attribute.
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To set up a moving average (Log Ratio) calculation to smooth the 
data

1 Analysis Moving Average, Show

2 Algorithm, Linear Triangular.

• Linear

• Triangular –

3 Line width, 

4 Window,

NOTE • If the original arrays change, you can manually update the combined array. Fuse the 
same set of arrays again. 

• If you want to combine many arrays, consider importing an array attributes file. See “To 
import array attributes” on page 48.

• When you combine (fuse) arrays, the centralization algorithm (if selected) is applied to 
the individual arrays before they are combined.
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To set up a moving average (ZScore) calculation to smooth the data

1 Analysis Moving Average (ZScore) 
Show

2 Algorithm, Linear Triangular. 
.

Linear

Triangular –

3 Line width, 

4 Window,
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To apply methylation (CH3) event detection

1

2

3 Analysis

4 Probe Methylation Select ZScore
Apply

5 Browse

6 Open

7 Continue
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To apply BATMAN (Bayesian Tool for Methylation Analysis)

1 Analysis Batman

Batman Parameter Setup
.

2 Continue 
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Displaying results and generating reports

To display results of analysis

Results for probe methylation and log ratios compared to a CpG Island track

Figure 19 Gene View, showing Z-score data next to log ratios and a CpG Island track
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Results for moving averages within genomic boundaries of CpG Island track

If the analysis results do not appear in any of the Views

•
Apply

•

•

1 View Preferences

2 View

3 Data Visibility, View, All views,

Figure 20 Gene View, showing moving averages within genomic boundaries of tracks
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4 OK.

•

To upload a track to UCSC 

1 Upload track to UCSC

2 Methylation Score 
OK

3
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Figure 21 Uploaded track in UCSC browser

To save a result

If you are saving a result for the first time for the experiment:

1
Save Experiment Result

Home > Save Experiment Result.

2 Yes

3 OK.
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If you have already saved at least one result for the experiment:

1

2 Home > Save Experiment Result 

Save Experiment Result

•  
Overwrite Current Result.

•  
Create New Result.

•
 Continue Without Saving.

To restore a saved result to the display

1

2
Results

3 Restore result.

To generate a probe report

•

•

•
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•

•

1 Reports Generate Report

2
Complete Genome

Per- Chromosome

3 Browse

4 Open

5 OK

6 Yes
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Figure 22 Excel methylation report for Complete Genome
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To generate a Batman report

•

•

•

Figure 23 List of text methylation reports for each chromosome
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•

1 Reports Generate Batman Report.

2
Complete Genome

Per- Chromosome

3 Browse

4 Open

5 OK

6 Yes
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Figure 24 Excel Batman report for complete genome
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Agilent Genomic Workbench CH3 Application Main Window

Figure 25 Agilent Genomic Workbench 7.0 – CH3 application main window

Cursor

Gene ViewChromosome View
Genome View

Tab View

Status Bar

Navigator

Switch Application

Tabs

Command Ribbon
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Switch Application Menu 

Figure 26 Switch Application menu

CGH

ChIP

CH3

SureSelect Target
Enrichment SureSelect Quality Analyzer User Guide
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Command Ribbons

• Sample Manager User Guide

Figure 27 Tab bar with command ribbon

Home command ribbon 

Figure 28 Home command ribbon

User Preferences
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Import

Tab Description

Tracks Opens a dialog box that lets you manage which tracks to display in 
Genomic Viewer and how they appear. See “User Preferences” on 
page 231.

Miscellaneous Opens a dialog box where you can select a new location for your 
data files and set up access to the eArray web site. See “User 
Preferences” on page 231.

License Opens a dialog box where you can enter an Agilent Genomic 
Workbench application license, if you purchase one after using the 
unlicensed version. See “User Preferences” on page 231.

Option Description

Array Files Opens a menu with these options:
• FE File – Opens the Import FE Files dialog box, where you can 

select an Agilent Feature Extraction array data file to import. 
See “Import” on page 201 and “To import Agilent FE or Axon 
data files” on page 41.

• Axon File – Opens the Import Axon Files dialog box, where you 
can select Axon (*.gpr) files for import. See “Import” on 
page 201 and “To import Agilent FE or Axon data files” on 
page 41.

• UDF File – Opens the UDF Files dialog box, where you can select 
a Universal Data File (UDF) to import. See “Import” on page 201
and “To import a UDF file” on page 43.

Design Files Opens a menu with these options:
• GEML File – Opens the Import Design Files dialog box, where 

you can select Agilent GEML-based (*.xml) array design files for 
import. See “Import” on page 201 and “To import Agilent GEML 
design files” on page 39.

• Axon Design File – Opens the Import Axon Design Files dialog 
box, where you can select Axon (*.gal) array design files for 
import. See “Import” on page 201 and “To import Axon design 
files” on page 41.

Genome Build Opens the Import Genome Build dialog box, where you can import 
Agilent-supplied genome build files. See “Import Genome 
Build” on page 205 and “To import a genome build” on page 46.
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Export

Create
Experiment

Save Experiment
Results

Yes

Array Attributes Opens the Import microarray attributes dialog box, where you can 
select a microarray attributes file. See “Import” on page 201.

Track Opens the Import Track dialog box, where you can select a BED 
format track file for import, and create a display name for the track. 
See “Import Track” on page 206 and “To import tracks” on page 47.

Experiments Opens the Import Experiments dialog box, where you can select a 
ZIP format experiment file for import. See “Import 
(experiments)” on page 203 and “To import an experiment file” on 
page 49.

Option Description

Option Description

Experiments Opens the Export Experiments dialog box, where you can select 
one or more experiments for export as a single ZIP file. See “Export 
Experiments” on page 195 and “To export experiments” on 
page 72.

Tracks Opens the Export Tracks dialog box, where you can select one or 
more tracks to export as a single BED format file. See “Export 
Tracks” on page 196 and “To export tracks” on page 73.

Array Attributes Opens the Export Array Attributes dialog box, where you can select 
arrays and their attributes for export. See “Export Array 
Attributes” on page 191.
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Go to
Gene/Genomic

Location

Print

Exit
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Preprocessing command ribbon

Figure 29 CH3 Preprocessing command
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Analysis command ribbon

Moving Average (Log Ratio)

Show

View View Preferences

Moving Average. 

Algorithm

• Linear

Figure 30 CH3 Analysis ribbon

Figure 31 Moving Average (Log Ratio) command
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• Triangular

Line width

Window

Moving Average (ZScore)

Show

Algorithm

• Linear

Figure 32 Moving Average (ZScore) command
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• Triangular

Line width

Window

Probe Methylation

Select ZScore

Apply

Figure 33 Probe Methylation command
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Batman

Figure 34 Batman command

Apply

Reports command ribbon

Generate Probe
Report

Figure 35 CH3 Report command
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Generate Batman
Report

View command ribbon

View Preferences

Copy

Figure 36 View command ribbon 

Option Description

All Copies all panes of the main window to the Clipboard as an image.

Navigator Copies only the Navigator to the Clipboard as an image.

Tab View Copies only Tab View to the Clipboard as an image.

Genome view Copies only Genome View to the Clipboard as an image.
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Show

View In Table

Signal Intensity

Annotation

Cyto band info

View In Gene
View

NonUnique Probes

Highlight

Custom Data

Show

Help command ribbon

Figure 37 Help ribbon for CH3 application

Chromosome view Copies only Chromosome View to the Clipboard as an image.

Gene view Copies only Gene View to the Clipboard as an image.

Option Description



Methylation (CH3) Analysis Reference 5
Help command ribbon

Methylation (CH3) Analysis Guide 135

Table 3 Table of Agilent Genomic Workbench Help

Help Command Action

Application Guide Opens the Agilent Genomic Workbench application user guide for the 
selected application. 

Sample Manager Opens the Sample Manager User Guide, that shows how to use the 
Sample Manager module of Agilent Genomic Workbench to organize 
microarrays and edit their attributes.

Data Viewing Opens the Data Viewing User Guide that describes how to import, 
organize, manage, export and display data and other content (experiments, 
gene lists, tracks) within Agilent Genomic Workbench. It is targeted for 
users who have no DNA Analytics application license(s).

About Opens a message with information about the version number and 
copyright of the program.
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Navigator

Figure 38 Navigator panes

Search pane

Data pane

Experiment pane

My Entity List pane
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Pane Comments

Search Lets you search within any pane of the Navigator for a specific 
item (array or build, for example). You must type the entire array 
name or term; otherwise, use asterisks (*) as wildcards for 
unspecified strings. For example, type *1234* to find any item that 
contains “1234”. See “Search pane” on page 138.

Data Contains microarray data files, organized by application type, then 
by design and genome build. 

Shows all probe groups and microarray designs that are available 
to you, organized by folders.In general, you can:

• Expand or collapse folders to show or hide content
• Right-click the name of a folder or item to open a shortcut menu 

that lets you take action on the item.
See “Data pane – icons, special text, and buttons” on page 140 
and “Data pane – actions and shortcut menus” on page 140.

Experiment Contains Agilent Genomic Workbench experiments. Experiments 
are organizational units that contain links to microarray data and 
design files. In data analysis modules, experiments also contain 
saved results.

My Entity List Contains gene lists and tracks:
• Gene Lists are collections of genes of interest. You can create 

them within the program, import and export them, and apply 
them to Gene View and Chromosome View.

• Tracks are collections of annotation or other information that 
map to specific genomic locations. You can import, export, and 
combine tracks, and display them in Gene View with your array 
data and analysis results.

• See “My Entity List pane – Icons, buttons, and special text” on 
page 149.

My Networks Contains the biological networks/pathways that you found using 
Network Search or that you create using a literature search in 
eArrayXD. For more information, see the eArrayXD Users Guide.
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Search pane

Detach button

Resize buttons

Search term box

Pane list
All Panels.

Figure 39 Navigator – Search pane

Search term box Detach 
button

Resize 
buttons

Pane list 
button

Search term 
clear button

Search button

Scroll buttons
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Figure 40 Search pane selection list

Scroll buttons
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Data pane – icons, special text, and buttons

Data pane – actions and shortcut menus

Item Comments

An unexpanded folder (domain) that contains subfolders or other items.

An expanded folder. The items that it contains are visible in the Navigator.

Expands a folder to show its contents.

Collapses a folder to hide its contents.

A methylation array design. This folder contains array data for the design, organized by 
genome build.

A CGH array design. This folder contains array data for the design, organized by genome 
build.

A gene expression array design. This folder contains array data for the design, organized 
by genome build.

A ChIP array design. This folder contains array data for the design, organized by genome 
build.

A genome build folder within a specific design folder. This folder contains arrays for the 
specific genome build and design.

A single array data file.

Data created from a multi-pack array.

red text An item that matches the search term in a search.

(Dock out button) Moves the Data pane from the Navigator, and opens it in a, separate 
window.

(Collapse button, available only if the Data pane is not collapsed) Collapses the Data 
pane, and shows its title bar at the bottom of the Navigator.

(Expand button, available only if the Data pane is collapsed) Expands the Data pane.
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•

Data Folder

•

•

•

Design Folder

•

Genome Build Folder

•

Individual Arrays

•

Option Description

Update from eArray Updates the annotations for your array design from the eArray Web 
site. Agilent regularly updates annotations in eArray as new ones 
become available. See “To update probe annotation in design files” on 
page 63.

Note: In order to use this function, you must enter your eArray 
Username and Password in the Miscellaneous tab of the User 
Preferences dialog box. See “User Preferences” on page 231.

Delete Opens a Confirm dialog box. If you click Yes, the program permanently 
deletes the design and all arrays associated with it.

Option Description

Show Properties Opens the Design Properties dialog box. See “Design Properties” on 
page 183.

Delete Opens a Confirm dialog box. If you click Yes, the program permanently 
deletes all of the arrays in this genome build folder.
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•

ctrl

Shift

Option Description

Show Properties Opens the Microarray Properties dialog box. See“Microarray 
Properties” on page 208 and “To display or edit the attribute values of 
a specific array” on page 59.

Rename Opens an Input dialog box, where you can type a new name for the 
array. Click OK to rename the array.

Delete Opens a Confirm dialog box. If you click Yes, the program permanently 
deletes the array.
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Experiment pane – icons, special text, and buttons

Item Comments

Click to expand a folder and display its contents.

Click to collapse a folder and hide its contents.

A folder that contains files or other folders. 

A methylation array design. This folder contains array data for the design, organized by 
genome build.

A CGH array design. This folder contains array data for the design, organized by genome 
build.

A gene expression array design. This folder contains array data for the design, organized 
by genome build.

A ChIP array design. This folder contains array data for the design, organized by genome 
build.

A genome build folder within a specific design folder. This folder contains arrays for the 
specific genome build and design.

An array that is not selected for view and analysis.

An array that is selected for view and analysis. The specific color of this icon can vary.

A calibration array.

An empty folder.

Data created from a multi-pack array.

blue 
text

The active experiment. All data and results that appear in Chromosome, Gene, and Tab 
Views are from this experiment.

red text An item that matches the search term in a search.

(Dock out button) Moves the Experiment pane from the main window, and opens it in a, 
separate window.

(Collapse button, available only if the Experiment pane is not collapsed) Collapses the 
Experiment pane, and shows its title bar at the bottom of the Navigator.

(Expand button, available only if the Experiment pane is collapsed) Expands the 
Experiment pane.
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Experiment pane — actions and shortcut menus 

• Experiments

Yes.

Experiments Folder

• Experiments

Figure 41 Expanded Experiment Pane

Option Description

New Experiment Opens the Create Experiment dialog box (see “Create Experiment” on 
page 178), where you can name the new experiment, and open 
another dialog box that lets you add microarray data to the 
experiment. See “To create a new experiment” on page 51.

Export Opens the Export Experiments dialog box, where you can export one 
or more experiments as a single ZIP file. See “Export Experiments” on 
page 195 and “To export experiments” on page 72.
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Specific Experiment Folder

• Experiments

Option Description

Select Experiment (Appears only if the experiment is not selected.) Opens the 
Experiment Selection dialog box, which asks if you want to select the 
experiment. Click Yes to select the experiment for display and 
analysis.

Or, in the Experiments folder, double-click the name of an experiment 
that is not selected to open the Experiment Selection dialog box. To 
select the experiment for analysis, click Yes.

If you switch experiments, a Confirm dialog box asks if you want to 
save the current result. Select one of these options:

• Overwrite Current Result – Replaces the selected experiment 
result in the Data Navigator with the result that appears on your 
screen.

• Create New Result – Opens the Save experiment result dialog box, 
where you can save the result that appears in the main window as 
a new experiment result. See “To save a result” on page 114.

• Continue Without Saving – The program does not save the result 
that appears on your screen.

In some cases, the Confirm dialog box offers only Yes and No choices. 
If you click Yes, the Save experiment result dialog box appears, where 
you can save the result that appears on your screen with the name of 
your choice.

Deselect Experiment (Appears only if the experiment is selected.) If the results are unsaved, 
a Confirm dialog box opens with these options:

• Overwrite Current Result – Replaces the selected experiment 
result in the Data Navigator with the result that appears on your 
screen.

• Create New Result – Opens the Save Experiment result dialog box, 
where you can save the result that appears on your screen as a 
new experiment result.

• Continue Without Saving – The program does not save the result 
that appears on your screen.

In all three cases, the program then removes the experiment data and 
results from all views.
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Design Folder

•
Delete,

Yes

Show Properties Opens the Experiment Properties dialog box. Use this dialog box to 
see the names of the arrays in the experiment, and also to add or 
remove arrays from the experiment. See “Experiment Properties” on 
page 188.

Sample Attributes Opens the Sample Attributes dialog box, where you can change the 
values for the attributes assigned to the arrays in the experiment. See 
“Sample Attributes” on page 213. To add new attributes you must use 
the Sample Manager. See Sample Manager User Guide.

Export Opens the Export Experiments dialog box, where you can export this 
and other experiments as a single ZIP file. See “Export 
Experiments” on page 195, and “To export experiments” on page 72.

Export Attributes Opens the Export Array Attributes dialog box, where you can save a 
file that contains selected attributes of the arrays in your experiment. 
See “Export Array Attributes” on page 191.

Edit Array Color Opens the Edit Array Color dialog box, where you can select a display 
color for each of the arrays in the experiment. See “Edit Array 
Color” on page 186.

Edit Array Order Opens the Edit Array Order dialog box, where you can change the 
order of the arrays in the experiment pane of the Navigator, and in 
Chromosome, Gene, and Tab Views. See “Edit Array Order” on 
page 187.

Rename Opens an Input dialog box, where you can type a new name for the 
experiment. Click OK to rename the experiment.

Delete Opens a Confirm dialog box that asks if you want to delete the 
Experiment. Click Yes to delete it.

Note: You can delete any experiment except the selected one.

Option Description
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Genome Build Folder

•

Individual Arrays

•

Option Description

Set for Calibration Use of calibration arrays is not recommended by Agilent. This feature 
has been deprecated.

Save As Text File Opens the Save Design dialog box, where you can save all of the data 
for the genome build and design within the experiment as a 
tab-delimited text file.

Delete Opens a Confirm dialog box that asks if you want to disassociate all 
arrays under the design from the experiment. Click Yes to remove the 
links between the arrays and the experiment.

Note: 

• If you delete a design from an experiment, the program removes the 
links between the experiment and the design and its arrays. The 
actual design and array data stay in the Data folder.

• Saved results become unavailable if they involve arrays you delete 
with this command.

Option Description

Select (Available only if the array is not already selected) Selects the array for 
display and analysis. 

Deselect (Available only if the array is selected) Removes the array data from 
Genome, Chromosome, and Gene views, and excludes it from the 
analysis. Also removes the array data from the Selected Arrays tab in 
Tab View.

Select for Calibration Use of calibration arrays is not recommended by Agilent. This feature 
has been deprecated.

Deselect from 
Calibration

Use of calibration arrays is not recommended by Agilent. This feature 
has been deprecated.
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Rename Opens an Input dialog box, where you can type a new name for the 
array in this experiment. Click OK to accept the new name for the 
array. The array name is changed only for the selected experiment.

Delete Opens a Confirm dialog box that asks if you want to disassociate the 
array from the experiment. Click Yes to remove the link between the 
array and the experiment.

Note: 

• If you delete an array from an experiment, the program removes the 
link between the experiment and the array. The actual array data 
remains in the Data folder. 

• You cannot restore an experiment result that includes a deleted 
array.

Show Properties Opens the Microarray Properties dialog box, where you can view and 
edit microarray attributes. See “Microarray Properties” on page 208.

For array files from the Agilent Feature Extraction program, you can 
also view the headers and feature data from the file.

See “To display or edit the attribute values of a specific array” on 
page 59.

Edit Array Color Opens the Select Color dialog box, where you can select a display 
color for the array. See “Select Color” on page 216.

Edit Array Order Opens the Array Order dialog box, where you can change the order of 
the arrays in the Experiment pane of the Navigator, and in 
Chromosome, Gene, and Tab Views. See “Edit Array Order” on 
page 187.

Option Description
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My Entity List pane – Icons, buttons, and special text

My Entity List pane – Actions and shortcut menus

Gene List folder

• Gene List
Import Gene List 

• Gene List

Item Comments

Click to expand a folder and display its contents.

Click to collapse a folder and hide its contents.

A folder that contains files or other folders.

An individual gene list or track.

red regular 
text

An item that is an exact match with the search term in a search, or a gene list that 
has not been applied or that has red chosen as its custom color.

colored 
italics

A gene list that has been applied.

red bold 
italics

A track that is selected for display in Gene View.

black bold 
italics

A “combined” track that is selected for display in Gene View. A combined track 
contains information from two or more individual tracks associated by logical 
criteria.

(Dock out button) Moves the My Entity List pane from the main window, and opens 
it in a, separate window.

(Collapse button, available only if the My Entity List pane is not collapsed) Collapses 
the My Entity List pane, and shows its title bar at the bottom of the Navigator.

(Expand button, available only if the My Entity List pane is collapsed) Expands the 
My Entity List pane.
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• Gene List

Tracks folder

•

Option Description

View in Table Opens the Gene List dialog box, where you can view the list of genes. 
You can also edit the description of the gene list, and change the 
display color of the genes. See “Gene List” on page 199 and “To 
display the genes in a gene list” on page 66.

Rename Opens an Input dialog box, where you can type a new name for the 
gene list. Click OK to accept the new name.

Delete Opens a confirm dialog box that asks if you are sure you want to 
delete the gene list. Click Yes to confirm.

Save As Opens a Save As dialog box, where you can save the gene list as a text 
(*.txt) file. See “To export a gene list” on page 73.

Add to gene list Opens the Add gene list dialog box, where you can add the gene list to 
any other one in the Gene List folder. See “Add Gene List <name> 
to” on page 166 and “To add one gene list to another” on page 67.

Highlight (Available if the gene list is not selected.) Displays all genes in Gene 
View, and highlights the genes from the gene list in their display color. 
See “To show gene lists in Gene View” on page 90.

Show only (Available only if all genes appear in Gene View, or if the gene list is 
not selected) Restricts the genes in Gene View to those on the gene 
list. No other genes appear. The program displays the genes in their 
display color. See “To show gene lists in Gene View” on page 90.

Show All (Available only for the selected gene list.) In Gene View, displays all 
genes, without highlighting. See “To show gene lists in Gene 
View” on page 90.



Methylation (CH3) Analysis Reference 5
My Entity List pane – Actions and shortcut menus

Methylation (CH3) Analysis Guide 151

Track name

•

Option Comments

Import Tracks Opens the Import Track dialog box, where you can import a 
BED format track file into the program. See “Import Track” on 
page 206 and “To import tracks” on page 47.

Export Tracks Opens the Export Tracks dialog box, where you can select 
tracks for export as a single BED format track file. See “Export 
Tracks” on page 196 and “To export tracks” on page 73.

Combine Tracks Opens the Combine Tracks dialog box, where you can 
associate two or more individual tracks by logical criteria to 
create a new combined track. See “Combine Tracks” on 
page 172 and “To combine tracks” on page 68.

Option Comments

Show in UI Mark this option to display the track in Gene View next to the 
data and results of the selected experiment. See “To show 
tracks in Gene View” on page 92.

Show in Report Mark this option to display the track in the reports. 

Genomic Boundaries Click to analyze data invoking the genomic boundaries for only 
that track. You can choose to do this for only one track.

Show in UCSC Opens the UCSC Genome Browser in your Web browser and 
uploads the track. You can then view the track. 

View Details Opens a dialog box that displays information about the track. 
See “Track” on page 223.

Rename Opens an Input dialog box, where you can type a new name for 
the track. Click OK to rename the track.

Delete Opens a Delete Track dialog box that asks if you are sure you 
want to delete the track. Click Yes to delete the track.
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Genomic Viewer

Genome View

Figure 42 Genome View (vertical orientation), with human chromosomes. The X chro-
mosome is selected.

Resize 
buttons

The View Cursor

Detach button

Selected 
chromosome
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Genome View actions and shortcut menus

•

•

•
View Preferences,

• Detach

Close

•

•



5 Methylation (CH3) Analysis Reference
Chromosome View

154 Methylation (CH3) Analysis Guide

Chromosome View

•

•

•

•

Figure 43 Chromosome View, human X chromosome shown

The View Cursor

Selected region

Detach button

Chromosome name

Plot
area

Resize buttons

Cytobands

Chromosome

Log ratio axis
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Chromosome View actions and shortcut menus

•

•

•
View Preferences,

• Detach

Close

•

•
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Gene View

•

Figure 44 Gene View, with log ratio data from an experiment and CNV tracks. 

Genes

The View 
Cursor

Plot area

Log ratio
axis

Chromosomal 
location axis Displayed region

Detach button

CNV 
Tracks
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•

•

•

•

Scatter Plot

View 

Methylation
Results

Log Ratios

Figure 45 Scatter Plot command group in CH3 Gene View 
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Configure Colors
and Ranges

Gene View buttons

Resize

Detach

Gene View shortcut menu and other actions

•

•

•
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Option Description

Create Gene List Opens the Create Gene List dialog box, where you can create a 
new gene list based on the selected (or another) chromosomal 
region. See “Create Gene List” on page 180 and “To create a 
gene list” on page 65.

Upload Track to UCSC Opens the Upload Track to UCSC dialog box, where you can set 
parameters to upload the track to the UCSC (University of 
California at Santa Cruz) Genome Browser in your Web 
browser. You can then display the track and use the tools 
available in the UCSC Web site to examine the data. See 
“Upload Track to UCSC” on page 229.

Search Probes in eArray Opens the Search Probes in eArray dialog box, where you can 
set the region to search for probes in eArray.

User Preferences Opens the User Preferences dialog box, where you can set 
user preferences on three separate tabs. See “User 
Preferences” on page 231 for more information.

View Preferences Opens the View Preferences dialog box, where you set 
preferences for the Genomic Viewer. See “View 
Preferences” on page 236.
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The View Cursor

•

•

•

Figure 46 Genomic viewer showing view cursors

•

•

•
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•

Tab View

•

•

•

Figure 47 Tab View

Detach buttonResize buttons

Design tabs
Selected row

Selected 
array

Unselected 
array
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•

Tab View tabs and buttons

Design tabs

Arrays tab

Selected Arrays
tab

Resize

Detach

Tab View actions and shortcut menus

• array in a column heading

• array in a column heading
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Option Description

Rename Array Opens an Input dialog box, where you can type a new name for 
the array. This only changes the name of the array within the 
active experiment.

Remove Array From 
Experiment

Opens a confirmation dialog box. Click Yes to remove the link 
between the array and the active experiment. This command 
does not delete the data file from the program. To do this, see 
“To remove data or design files from the program” on page 64.

Select Array (Available if the array is not selected.) Selects the array for 
display. A colored square appears next to the name of the 
array.

Deselect Array (Available if the array is selected.) Removes the array data 
from scatter plots, and removes the column of the array from 
the Selected Arrays tab.

Edit Array Color Opens the Select Color dialog box, where you can change the 
display color of the array. See “Edit Array Color” on page 186 
and “To change the display color of an array” on page 81.

Edit Array Order Opens the Edit Array Order dialog box, where you can change 
the order in which the names of the arrays in a given design of 
the active experiment appear in Tab View and in the Data 
Navigator. In Gene View, when you view separate scatter plots 
for each array, the plots also appear in this order. See “Edit 
Array Order” on page 187 and “To change the order of arrays in 
an experiment” on page 54.

Select All Arrays Selects all arrays in all designs in the active experiment for 
display. All arrays appear in the Selected Arrays tab.

Deselect All Arrays Removes all arrays from display, and from the Selected Arrays 
tab.

Scroll to Column Opens the Scroll to Column dialog box, where you can select a 
column in the current tab. The program then scrolls the data 
table in the tab so you can see the selected column. See 
“Scroll to Column” on page 214.
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• heading of a column other than an array data column

• an entry in a data table

• data table entry

Option Description

Find in column Opens the Find in column dialog box, where you can search for 
a specific text string within the column you clicked. See “Find 
in column” on page 197.

Google
LocusLink

PubMed

UCSC HG15(April ‘03)

UCSC HG16(July‘03)

UCSC HG17(May‘04)

UCSC HG18(March‘06)

UCSC mm8(Feb‘06)

UCSC mm9(July‘07)

DGV(hg18)

GO

KEGG(HUMAN)

Opens your Web browser, and sends the column entry you 
clicked as a search string to the selected site. The UCSC links 
search the indicated University of California, Santa Cruz 
database related to the indicated genome build. See “To 
search the Web for information on probes in Tab View” on 
page 100.

Customize Link Opens the Customize Search link dialog box, where you can 
create or edit a custom Web link that appears in this shortcut 
menu. When you click a custom link, the program opens your 
Web browser, and sends the column entry you clicked as a 
search string to the site. See “Customize Search Link” on 
page 182 and “To create a custom Web search link” on 
page 100.

(other options) If other options appear in this shortcut menu, they are custom 
Web search links. Click them to open your Web browser, and 
send the column entry you clicked as a search string to the 
site.
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Status Bar

Cursor position

Genome build

Ratio type

• ratio

• log2 ratio

• log10 ratio

• ln (natural log) ratio

Selected Row

Table size

Figure 48 Status bar 

Genome build Ratio type

Table size

Cursor position
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Dialog Boxes

Add Gene List <name> to

Purpose:

To open: 
Add to Gene List.

Select target
gene list

Build

Figure 49 Add Gene List <name> to
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Description

List of genes

Gene List Color

OK

Cancel

Agilent Feature Extraction Importer

Purpose:

Figure 50 Agilent Feature Extraction Importer
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To open:  Import > Array Files > FE File,
Open.

Name

Dye Flip

Normal

•

•

•

Flipped

•

•

•

Overwrite arrays
with duplicate

names

Run in
Background

OK

Cancel
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Array Set

Purpose

To open Fuse

Table

Select
Normalization

Remove arrays
from experiment

after fuse

Continue

Cancel

Figure 51 Array Set dialog box.
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Batman Parameter Setup

Figure 52 Batman Parameter Setup dialog box

Purpose:

To open: Analysis Batman Apply

Z-score

Select CPG
Window

Select CPG File Browse

Select TM
mapping file Available
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Continue

Cancel

Batman Report Dialog

Figure 53 Batman Report Dialog

Purpose:

To open Generate Batman Report

Report Type

Output Format Complete Genome
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Per- Chromosome

Select File
Location

Browse

Combine Tracks

Purpose:

To open: My Entity List Tracks
Combine Tracks.

Name

New Condition

Delete Condition

Track

Figure 54 Combine Tracks dialog box
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Operator

Reset

Save

Close

Operator Comments

AND Places an element in the combined track if it appears in both this track and any of 
the others.

OR Places an element in the combined track if it appears in either this track or any of 
the others. If you set this operator for all tracks in the list, the result is a 
nonredundant set of elements from all tracks.

MINUS Removes the elements that appear in this track from the combined track, if they 
otherwise appear there.
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Configure Coloring Ranges and Shades

Figure 55 Configure Coloring Ranges and Shades dialog box

Purpose:

To open: Scatter Plot
Configure

View View Preferences
Configure Colors and Ranges.
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Table 4 Methylation Results Parameters

Parameter Description

Z-score Values

Min Type a minimum value for the range.

Max Type a maximum value for the range.

Color Click to open the Select Color dialog box, where you can select the 
color you want to display for this range. See “Select Color” on 
page 216 for more information.

Add Range Click to add a row to the range table using the values displayed in Min 
and Max, and the selected Color.

Remove Range Click to remove the ranges with Edit/Delete box marked.

Edit Range Click to edit range(s) with Edit/Delete box marked.

Range table This table displays the defined ranges, including minimum and 
maximum values, color for each range, and Edit/Delete selection.

Table 5 Log Ratios Parameters

Parameter Description

Log Ratio Values

Min Type a minimum value for the range.

Max Type a maximum value for the range.

Color Click to open the Select Color dialog box, where you can select the 
color you want to display for this range. See “Select Color” on 
page 216 for more information.

Add Range Click to add a row to the range table using the values displayed in Min 
and Max, and the selected Color.

Remove Range Click to remove the ranges with Edit/Delete box marked.

Edit Range Click to edit range(s) with Edit/Delete box marked.

Range table This table displays the defined ranges, including minimum and 
maximum values, color for each range, and Edit/Delete selection.
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Probe Score Values

Min Type a minimum value for the range.

Max Type a maximum value for the range.

Color Click to open the Select Color dialog box, where you can select the 
color you want to display for this range. See “Select Color” on 
page 216 for more information.

Add Range Click to add a row to the range table using the values displayed in Min 
and Max, and the selected Color.

Remove Range Click to remove the ranges with Edit/Delete box marked.

Edit Range Click to edit range(s) with Edit/Delete box marked.

Range table This table displays the defined ranges, including minimum and 
maximum values, color for each range, and Edit/Delete selection.

Table 5 Log Ratios Parameters (continued)

Parameter Description
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Confirm Overwrite

Purpose:

To open:

Select the designs to overwrite

Design

Overwrite

Select All

Deselect All

Figure 56 Confirm overwrite dialog box
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Select the microarrays to overwrite

Array

Name

Overwrite

Select All

Deselect All

OK

Cancel

Create Experiment

Purpose

To open
New Experiment File > New 

Experiment

Figure 57 Create Experiment dialog box
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Name

Description

Properties

NOTE Do not click OK until you have added arrays to your experiment in the Experiment 
Properties dialog box or you will have an empty experiment. You can also add arrays to the 
experiment later, by dragging and dropping the arrays from the Data pane of the navigator. 
See “To add arrays to an experiment” on page 53.
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Create Gene List

Purpose

To open Create Gene List

Name

Build

Description

Set Chromosome Start-Stop

Figure 58 Create Gene List dialog box
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User Defined

For complete
gene view

For aberrant
region below

cursor

Chromosome

Start

Stop

Color

Change
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Customize Search Link

Purpose

To open
Customize Link.

URL Name

URL
<target>

http://www.google.com/search?hl=eng&q=<target>

New
OK

Update

Delete

Close

Figure 59 Customize Search Link dialog box
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Design Properties

Purpose:

To open:
Show Properties. 

Attribute tab

Non Unique Probes tab

Figure 60 Design Properties dialog box – Attribute tab
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S. No

Probe

Value

Figure 61 Design Properties dialog box – Non Unique Probes tab
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Data tab

Select
Chromosome

Probe

Chromosome

Start

Stop

Figure 62 Design Properties dialog box – Data tab
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Edit Array Color

Purpose

To open Edit Array Color

Select Array

Color

Select All

Deselect All

Edit Color

Restore default

Figure 63 Edit Array Color dialog box



Methylation (CH3) Analysis Reference 5
Edit Array Order

Methylation (CH3) Analysis Guide 187

Edit Array Order

Purpose: 

Stacked

To open: Edit Array 
Order

Array Name

Design

Order by

Figure 64 Edit Array Order dialog box
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OK

Cancel

Experiment Properties

Purpose

To open Properties

Show Properties

Experiment
Name:

Description
Text Box:

Select Design

Designs

Figure 65 Experiment Properties dialog box
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Genome Builds

Arrays

Array List

•

• ctrl 

•
Shift 

Selected Array
List

Display name by

Sample Manager User Guide

OK

Cancel
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Export

Purpose

To open: 

Look in

Look in.

Figure 66 Export dialog box – Several types of file exports use this dialog box. This spe-
cific example exports selected experiment(s) as a ZIP format file.
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Main pane
Look in.

File name

Files of type
All Files.

Export

Cancel

Export Array Attributes

Purpose:

To open: Export > Array Attributes

Export Attributes.
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Array tab

Select Design

Designs

Genome Builds

Arrays

Array List

•

• ctrl 

•
Shift 

Figure 67 Export Array Attributes dialog box – Array tab
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Selected Array
List

Next

Cancel

Attribute Tab

Figure 68 Export Array Attributes dialog box – Attribute tab
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Attributes

Attribute List

Selected
Attribute List •

• ctrl 

•
Shift 

Back

OK

Cancel

NOTE You must select the following mandatory attributes, or else you cannot import the attribute 
file at a later time: Array ID, Global Display Name, Green Sample, Red Sample, Polarity.
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Export Experiments

Purpose:

To open: Export > Experiments.

Select experi-
ments to export

Select All

Deselect All

OK

Cancel

Figure 69 Export Experiments dialog box
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Export Tracks

Purpose:

To open: Home Export > Tracks.

Select tracks

Select All

Deselect All

OK

Figure 70 Export Tracks dialog box
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Cancel

Find in column

Purpose

To open
Find in column

Find in column

Direction

• Up

• Down

Conditions

• Match Case
aa351

aa351.
not AA351 Aa351.

Figure 71 Find in column dialog box
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• Match whole word

AA351 Match whole word,
AA351

AA3512 AA351992.

Find Next

Cancel
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Gene List

Purpose:

To open My Entity List
View in Table.

Name

Description

Figure 72 GeneList dialog box
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S. No

Gene Names

Color

OK

Cancel

Go To Gene/Genomic Location

Purpose

To open Home > Go to Gene/Genomic location

RefSeq by Symbol Go.

Genomic Location • Chromosome

Figure 73 Go To Gene/Genomic location dialog box
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• Base Position

Go

Cancel

Import

Purpose

To open: Import,

Gene List
Import 

Gene List.

Figure 74 Import dialog box
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ctrl 

Shift 

File name

Files of type
All Files.

.

Import or Open
Open, Import. Import,

Cancel

File type Extension

FE array File *.txt

Axon array file *.gpr

UDF file *.txt

Design file (GEML) *.xml

Axon design file *.gal

Array attributes *.txt

Experiments *.zip

Filters *.xml

Gene list *.txt



Methylation (CH3) Analysis Reference 5
Import (experiments)

Methylation (CH3) Analysis Guide 203

Import (experiments)

Purpose:

To open: Home Import > Experiments.

Import.

Select
experiments to

import
• Import

• Experiment

Select All

Deselect All

OK

Figure 75 Import dialog box (for experiments)
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Cancel

Import GEML design files

Purpose

To open: Import > Design Files > GEML File.
Open.

File Name

ID

Type

Figure 76 Import GEML design files dialog box
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Species

Genome Build
Genome Build

Status • Not Set

• Not Allowed

• Overwrite

• Valid

Remove

Start Import

Cancel

Import Genome Build

Purpose:

To open:  Import > Genome Build.

Figure 77 Import Genome Build dialog box
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Species

Build Name

Refseq File
Browse.

CytoBand File

Browse.

OK

Cancel

Import Track

Purpose:

To open: Home Import > Track.

Species

CAUTION Import only Agilent-supplied genome build files. 

Figure 78 Import Track dialog box
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Build Name

Color
Change.

Track Name

Track File
Browse

Browse

OK

Cancel
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Microarray Properties

Purpose:

Sample Manager User Guide

To open: 
Show Properties.

Attribute tab

• Attribute

• Value

Figure 79 Microarray Properties dialog box with list of Attributes and their values
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Close

FE Headers Tab

Index

Name

Value

Close

NOTE You cannot edit values for read-only arrays.

Figure 80 Microarray Properties dialog box with list of FE Headers and their values
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FE Features Tab

Selection List

List Box

Figure 81 Microarray Properties dialog box with list of FE Features and associated data
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Probe Methylation Status Setup

Purpose

To open Analysis Apply Probe Methylation

Design Name

Tm Map File Browse

Continue

Cancel

Figure 82 Probe Methylation Status Setup dialog box



5 Methylation (CH3) Analysis Reference
Probe Methylation Report Dialog

212 Methylation (CH3) Analysis Guide

Probe Methylation Report Dialog 

Purpose

To open Reports Generate Probe Report

Report Type

Output Format Complete Genome

Per- Chromosome

Select File
Location

Browse

Figure 83 Probe Methylation Report dialog box
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Sample Attributes

Purpose

To open
Sample Attributes

Sample Manager User 
Guide

Figure 84 Sample Attributes dialog box

NOTE Changes to array attributes you make in this table appear also in the Sample Manager 
table.
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Scroll to Column

Purpose

To open Scroll To 
Column

Select column

OK

Cancel

Figure 85 Scroll to Column dialog box
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Search Probes in eArray

Figure 86 Search probes in eArray dialog box

Purpose

To open Search probes in eArray

User Defined

For complete
gene view

For aberrant
region below

cursor

Chromosome

Start/Stop
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Select Color

Purpose:

•

•

•

To open:
Edit 

Array Color Swatches, HSB, RGB 

Swatches tab

Preview

Figure 87 Select Color - Swatches tab
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Recent:

OK

Cancel

Reset

HSB Tab

Hue H

Saturation S

Brightness B

Figure 88 Select Color - HSB Tab
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RGB Numbers

Preview

OK

Cancel

Reset

RGB Tab

Red

Green

Figure 89 Select Color - RGB Tab
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Blue

Preview

OK

Cancel

Reset

Select data type for experiments

Purpose:

To open: Home Import > Array Files > UDF File.
Open.

Experiment Name

Data Type

• ratio

Figure 90 Select data type for experiments dialog box
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• log2 ratio

• log10 ratio

• ln ratio 

Design type

Continue

Cancel

Set genome build and species for Axon design files

Figure 91 Set genome build and species for Axon design files dialog box
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Purpose: 

To open: Import > Design Files > Axon File.

Import.

No.

File Name

Species

Genome Build

Status

• Valid

• Healthy

• Not Set

• Not Allowed

• Overwrite

• Corrupt

Remove

Start Import

Cancel
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Show/Hide Columns

Figure 92 Show/Hide Columns dialog box

Purpose

Sample Manager User Guide

To open: Show/Hide Attributes

Show in Table
Show in Table 

Save

Select All

Deselect All
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Close

Track

Purpose

To open Details

Figure 93 Track details dialog box
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Track Parameters

Data

Close

Parameter Description

Name The name of the track.

Species The species to which the track applies.

Format The format of the track data. Agilent Genomic Workbench supports 
the BED format.

Genome Build The specific genome build of the species to which the track applies.

Description Descriptive text saved with the track.

Column Description

Chromosome The name of the chromosome

Start The first base pair of the particular feature in the chromosome.

Stop The last base pair of the particular feature in the chromosome.

Name The name of the feature. This name appears next to the defined region 
for the feature.
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UDF Import Summary

Purpose:

To open:

Table

OK

Figure 94 UDF Import Summary dialog box 
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Universal Data Importer - Map Column Headers

Purpose:

To open:

Continue.

Species Info

Select Species

Select Genome
Build

Figure 95 Universal Data Importer - Map Column Headers dialog box
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Mapping Info

Select Mapping

CUSTOM.

Save Mapping As

Array ID Info

Virtual Array ID

Use System
Generated Array

ID Use System Generated Array ID, Virtual 
Array ID.

Table

Label Description

ProbeName Names of probes.

ChrName Names of chromosomes.

Start First chromosomal location for each probe.
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Reset

Import

Cancel

Stop Last chromosomal location for each probe.

Description Text annotation for the probe.

LogRatio Array data values that correspond to each probe. You can use this 
label more than once.

Label Description

NOTE If you select an existing column mapping, then change or reset the column labels in the 
table, the program changes or resets the saved column map as well. 
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Upload Track to UCSC

Figure 96 Upload Track to UCSC dialog box

Purpose:

To open Upload Track to UCSC

Name

Build User Defined Set Chromosome Start- Stop.

Description

Set Chromosome
Start-Stop
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• User Defined

Chromosome, (Start) (Stop)

• For complete gene view

• For aberrant region below cursor
 

Select Track
Source

• Methylation Score 

Save as Track in
Genomic

Workbench

OK Tracks

Cancel
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User Preferences

Purpose: 

To open:  User Preferences
User 

Preferences

Tracks tab

Purpose

To open Tracks

Figure 97 User Preferences dialog box - Tracks tab 
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Font Options

Tracks List

Track Name

Show in UI

Show in Report

Genomic
Boundaries

Delete Delete

Details

Import

Delete

Up

Down

Visualization Parameters

Genes

•

•

Genomic
Boundaries

Tracks

•
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•

Miscellaneous tab

Figure 98 User Preferences dialog box – Miscellaneous tab

Purpose:

To open: Miscellaneous

eArray User
Details • URL

• Username

• Password
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Error Model

Data Location
Browse.

Apply

OK

Cancel

License tab

Figure 99 User Preferences dialog box – License tab 
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Purpose: 

To open: License

Host Name

Select Analysis
Application

Server Location
Server Location,

Text License

OK

Cancel

Apply
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View Preferences

Figure 100 View Preferences dialog box

Purpose: 

To open: View Preferences.
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View Alignment

Data Visibility

View,
All views.

Option Description

Orientation

Horizontal Stacks Genome, Chromosome, and Gene views horizontally in the 
main program window. Genomic locations appear across the bottom 
of each view.

Vertical Displays Genome, Chromosome, and Gene views from left to right as 
side-by-side panes in the main program window.

Rendering Style

Overlaid In Chromosome View and in Gene View, displays data and results as a 
single, combined pane for all arrays. (Default)

Stacked In Chromosome View and in Gene View, displays a separate pane for 
each array.

Display item Description/Comments

Scatter Plot The plot(s) of individual log ratio data points.

Scatter Tool Tip The ToolTips that appear when you place the pointer over specific data 
points on the scatter plot(s) in Gene View. The tool tip shows the array 
of origin and the numerical log ratio value for the data point.

Moving Average The result of the Moving Average algorithm. See “To set up a moving 
average (Log Ratio) calculation to smooth the data” on page 107.
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Rendering
Patterns

• Design Type
CH3, Expression, or Other.

• Styles

Scatter Plot (Chr
View) Point Size

ZScore Marking this check box displays the results from the methylation 
algorithm to produce the statistical likelihood of methylation or no 
methylation in CpG Island regions of the genome.

Log Ratio Error 
Envelope

Mark this check box to display the error envelope for log ratio values.

Display item Description/Comments

Display element Details

Log Ratios Select how to display individual data points as: Color filled circles 
(ellipses), circles, rectangles, filled rectangles, + signs, or x signs. 
The latter two choices increase performance. 

Moving Average Select the line style for the moving average display. Lines appear in 
the display color defined for each array. See “To set up a moving 
average (Log Ratio) calculation to smooth the data” on page 107.

• Continuous – A solid line.
• Dashed – A dashed line.
• Dotted – A dotted line.
• Do not show area – No line.

NOTE Rendering scatter plots for more than 10 high density arrays in the Chromosome View may 
take significant time. Selecting filled circles as the rendering style for CH3 scatter plots can 
also decrease performance. For faster performance, change the rendering style for CH3 
data from the filled circle to the plus (+) or cross hair sign.
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Configure Scales Apply

Configure
Coloring schemes

Show Memory
Monitor in Status

Bar

OK

Cancel

Apply
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Report Format

Column Description

CytoBand Accepted name of the cytoband for each section of chromosome

ChrName Name of the chromosome (for example, chr17)

ProbeName Name of the probe (for example, P)

Start The first base pair of the chromosomal location to which the probe 
binds

Stop The last base pair of the chromosomal location to which the probe 
binds

Description Name or phrase for the type of probe (for example, promoter)

GeneNames Names of each gene in whose region probes are located

“Name of CpG Island 
Track”

Name of each CpG Island in whose region probes are located

Combined ZScore Combination of both the methylated and unmethylated ZScores. The 
higher the positive combined ZScore, the more likely the probe is 
methylated and vice versa.

ZScore_Methylated Probe ZScore that are contained in right Gaussian. All of these values 
are positive or small negative values.

ZScore_Unmethylated Probe ZScore that are contained in left Gaussian. All of these values 
are negative or small positive values.

logOdds This number reflects how likely it is that a probe is methylated rather 
than unmethylated. The higher the positive value, the more likely it is 
methylated.
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logRatio Log ratio from the extracted FE image file for the probe

Tm Melting temperature for the probe region 

Column Description
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Overview of Methylation Detection and Visualization Algorithms

The Methylation module of A gilent Genomic Workbench provides 
algorithms for genomic methylation detection and visualization. The ma in 
methylation detection algorithms are described below. Information on 
algorithms that visualize the data follows.

Methylation detection and measurement algorithms

Methylation of cytosines in DNA is an epigenetic modification that can 
play a role in the regulation of gene expression. Generall y, methylation is 
associated with repression of gene expression. Much of the aberrant DNA 
methylation associated with abnormality is found in CG- rich regions, 
termed CpG islands.

Agilent catalog methylation (CH3) arrays are specifically designed to 
assess the methylation pattern within CpG islands and gene pr omoter 
regions. The m ethylation detection algorithm is designed to be compatible 
only with the Agilent protocol for DNA methylation analysis and the 
Agilent methods for affinity- based methylated DNA enrichment.1

Methylation status detection algorithm

The methylation status detection algorithm is designed f or two- color 
assays, where t he green (Cy3) channel  is comprised of input DNA, and the 
red (Cy5) channel is com prised of the affinity- enriched DNA. As a result 
of constraints imposed on the array design, the probes that target genomic 
regions with varying CG content do not share a uniform melting 
temperature (Tm), which can res ult in com pression of the log- ratios. 

The methylation detection algorithm allows you to normalize the log- ratios 
for each probe, based on i ts Tm, and retur ns the methylation status of a 
probe. This sharpens t he bimodal distribution observed with log- ratios 
alone. For more inf ormation, see “Methylation status detection 
algorithm” on page 246.

BATMAN algorithm

The BATMAN (BAyesian Tool for Methylation ANalysis) algorithm2 has 
been adapted here f or analysis of A gilent methylation microarrays. This 
algorithm takes into account the local density of CpG dinucleo tides in t he 
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Z

Visualization algorithms

Moving average – linear

Moving average – triangular smoothing
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Methylation Detection and Measurement Algorithms

Z-

Methylation status detection algorithm

Z
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Z

Purpose

Use

Algorithm

random 
hill climbing Z p

NOTE The logOdds score indicates how likely a probe is to be methylated. It compares p-values 
from the methylated to unmethylated populations. If they are the same, this value is zero.
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Step 1: Create a binned distribution of probes

7

8

Step 2: Fit Gaussian curves to the binned data

Figure 101 Overview of procedures in the methylation status algorithm
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•

•

•

1

2

Initial parameter
approximation

μ
σ α,

•

1

2

3

•

NOTE One Gaussian goodness of fit can exceed two Gaussians if, for example, no methylated 
probes were pulled down during the antibody enrichment process, or if the number of 
methylation events is exceedingly small. If this occurs, Agilent Genomic Workbench 
automatically fits one Gaussian to the data, and the message “SINGLE GAUSS” appears in 
the report. The Z-score in the visualization and report is then calculated from the single 
Gaussian (that is, how likely the probe is to be methylated), instead of a combined Z-score 
(which is reported from models using either two or three Gaussians).
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•

1

2

3

Parameter
improvement

procedure

n
LB

Target fitness
function ODi=1…N

EF

LB n+( )log
LB( )log

----------------------------- 1( )
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Step 3: Calculate Z-normalization scores

Z

μbin σbin
Z

Z

Z

Z

1 Z

2 Z

3 Z
Z-

χ2
ODi EFi

2
–

EFi
---------------------------- 2( )

i 1=

N

=

Z
log ratio– probe μbin–

σbin
-------------------------------------------------------- 3( )=



6 Statistical Algorithms
Methylation status detection algorithm

252 Methylation (CH3) Analysis Guide

Z
p

Figure 102 Effect of probe log-ratio score placement on a mixture of Gaussians – result 
ranges for Z-normalization score
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p

1 p

2 p

3

ω

Figure 103 Calculating Z-scores and p-values from two overlapping Gaussian distribu-
tions

ω
pM
pU
------- 4( )log–=
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Interpreting the
results

ω
ω

Visualization
Z

Z
Z

Z
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Output report

Figure 104 Output of methylation status detection algorithm. On the right side of Agilent 
Genomic Workbench, Gene View displays the moving average for both the 
Z-score (left pane of Gene View) and the probe log-ratios (middle pane of Gene 
View). Human CpG islands are displayed as a track along the right side of the 
moving averages. Note that the probe log-ratios, which are only slightly posi-
tive in this region (colored red), may take on negative combined Z-scores (col-
ored by sample).
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Bayesian tool for methylation analysis (BATMAN)

Table 6 Contents of methylation output report

Reported parameter Meaning

Z-score unmethylated Z-score derived from the left Gaussian. This is the probability 
that the observed value for a probe comes from the 
unmethylated population.

Z-score methylated Z-score derived from the right Gaussian. This is the probability 
that the observed value for a probe comes from the methylated 
population.

Combined Z-score Summation of the methylated and unmethylated Z-scores

pM The p-value derived from the left Gaussian. This is the 
confidence at which the non-methylated null hypothesis is 
rejected (that is, the confidence at which you can call the probe 
methylated).

pU The p-value derived from the right Gaussian. This is the 
confidence at which the methylated null hypothesis is rejected 
(that is, the confidence at which you can call the probe 
unmethylated).

logOdds The logOdds score ω; the likelihood that a probe is methylated 
rather than unmethylated.
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Z-

Purpose
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Use

Algorithm

Z-

Z

Step 1: Calibration step

et al Ccp

c n 
c m 

p
Z- Ctot

Ccp
m
n
----=

Ctot Ccp
p

=
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y

Step 2: Modeling and sampling

Ap Z- Abase
Mc c

Step 3: Summarization (Bayesian inference)

β̂1
x x–( ) yi y–( )

xi x–( )2
-------------------------------------------=

β̂0 y β̂1x–=

Var yd α̂ β̂xd+[ ]–( ) σ2 1 1
m
----

xd x–( )2

xd x–( )2
----------------------------+ +=

f A m( ) ζ Ap Abase r CcpMc v
1–,

c

+
p
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Step 4: Methylation calling

random hill climbing

Interpreting the
results

Visualization
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Visualization Algorithms

Z-

Z-

T

Moving average (linear smoothing)

Z-
w
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Triangular smoothing

Purpose

Z

Use

Z
Z

Algorithm

1

NOTE In linear smoothing, the user-defined point input (pt input) uses the same number of probes 
as in triangular smoothing. However, an equal number of probes is taken in each direction 
(to the left and right of the center probe) to compute the moving average. This might not be 
ideal if the probes are placed at varying distances.
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2
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W
Δ

Z

(1)

W Δ

(2)

Interpretation

Visualization

Figure 105 Triangular smoothing with pt input 

w x( ) W x–( ) W2⁄=

W Δ 2 2–( )⁄=
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Appendix

Methylation calling – the beta distribution

B

Figure 106 The beta distribution, illustrated with various parameter values

xα 1– 1 x–( )β 1–

B α β,( )
----------------------------------------
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